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1.  TEDS IEEE 1451.4 INTRODUCTION 

 
 

Model SST is a TEDS IEEE 1451.4 Plug and Play Smart Transmitter for TEDS IEEE 1451.4 com-

pliant Load Cell / Torque Sensors. Such sensors incorporate an EEPROM which specifies the type 

of sensor, its interface, and technical information such as sensitivity, bridge type, excitation, etc. 

TEDS, or Transducer Electronic Data Sheet, is a set of electronic data in a standardized format 

defined by the IEEE 1451.4 Standard.  

The SST transmitter automatically detects when a TEDS IEEE 1451.4 compliant Load Cell /  Torque 

Sensor has been connected to it by using a built-in EEPROM detector. It then reads the Sensor 

EEPROM, stores the information in its memory, and performs an automatic configuration. The 

EEPROM may be of any of the following types: DS1973/DS2433, DS2431 or DS1971/ DS2430A. 

The automatic system configuration function performs all steps needed to calibrate the TEDS IEEE 

1451.4 compliant Load Cell /  Torque Sensor and SST Transmitter as a system. This includes the 

configured precision of either 32 bits, 19 bits or 11 bits and the configured excitation voltage. 

Interfacing the SST Transmitter to a TEDS IEEE 1451.4 compliant Load Cell /  Torque Sensor is as 

easy as plugging a mouse into a computer, making it a true plug-and-play experience. 

 



 - 4 - 

2.  SST TRANSMITTER INTRODUCTION 

 
 

The SST Transmitter is an extremely accurate and versatile DIN rail transmitter for Load Cell / 

Torque Sensors. Standard features include: 

 Accuracy of 0.01% of full scale ± 1 count. 

 Update rate to 60/sec in 60 Hz noise environments or 50/sec in 50 Hz noise environments. 

 Full-scale range from 20.000 mV full scale (1 μV resolution) to 500.00 mV full scale  

(10 µV resolution).  

 Isolated transducer excitation output. 5V at 100mA or 10V at 120mA as selected by TEDS. In 

non-TEDS operation, the excitation is always 10V. 

 Isolated 4-20 mA, 0-20 mA, 0-10V or -10V to +10V analog output. The signal types are 

selectable via jumpers. The output tracks the transmitter’s internal digital reading, is scaled in 

software, and is generated by an ultra-linear 16-bit digital-to-analog converter. 

 Isolated serial data transmitter output. The transmitter serial port is default jumpered for 

RS232 or full-duplex RS485 (same jumper settings). Half-duplex RS485 is also selectable 

either via internal or external jumpers. Three serial protocols are software selectable: Modbus 

RTU, Modbus ASCII and Custom ASCII. Modbus allows devices by different manufacturers to 

be addressed on the same data line. The simpler Custom ASCII protocol is recommended 

when there are no devices by other manufacturers on the data line.  

 Dual solid state relays rated 120 mA at 140 Vac or 180 Vdc.  

 Isolation to 250V rms is provided for power, signal input, analog output, relay outputs, and 

communications. Isolation adds safety and avoids possible ground loops. The transducer 

excitation output is isolated to 50V from signal ground. 

 Internal jumpers are used to select the signal range, communication type, and excitation level. 

The transmitter configuration is specified by the model number on the transmitter label. A user 

can reconfigure the transmitter by opening the case and moving jumpers. 

 Transmitter setup is via serial connection to a PC using MS Windows based Instrument Setup 

Software plus TEDS IEEE 1451.4 when detected. The setup software can be downloaded at no 

charge from http://www.transducertechniques.com/online-manuals.aspx. The required trans-

mitter to PC interface cable is available for purchase. With a TEDS IEEE 1451.4 compliant 

Load/ Torque Sensor, the transmitter and sensor are calibrated as a system. 

 

http://www.transducertechniques.com/online-manuals.aspx
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3.  RECEIVING & UNPACKING YOUR TRANSMITTER 

 
Your transmitter was carefully tested and inspected prior to shipment. Should the transmitter be 

damaged in shipment, notify the freight carrier immediately. In the event the transmitter is not 

configured as ordered or is inoperable, please contact Transducer Techniques. 

4.  SAFETY CONSIDERATIONS 

 
 

 Warning: Use of this transmitter in a manner other than specified may impair the protection 

of the device and subject the user to a hazard. Do not attempt to operate if the unit shows visible 

damage. 

Cautions:  

 This unit may be powered from 95-240 Vac ±10% or with the worldwide voltage power supply 

option, or from 12-30 Vac or 10-48 Vdc with the low voltage power supply option. Verify that 

the proper power option is installed for the power to be used.  

 The 95-240 Vac ±10% power connector (P1 Pins 1-3) is colored Green to differentiate it from 

other input and output connectors. The 12-30 Vac or 10-48 Vdc power connector is colored 

Black. This transmitter has no power switch. It will be in operation as soon as power is 

applied. 

 To avoid dangers of electrocution and/or short circuit, do not attempt to open the case while 

the unit is under power.   

 To prevent an electrical or fire hazard, do not expose the transmitter to excessive moisture. 

Do not operate the transmitter in the presence of flammable gases or fumes, as such an 

environment constitutes an explosion hazard.  

Symbols used: 

 
Caution (refer to accompanying documents) 

 
Earth (ground) terminal. 

 

 
Caution, risk of electric shock.  Both direct and alternating current. 

 
Equipment protected throughout by double 

insulation or reinforced insulation. 
  

  

Operating environment: 

Transmitter Class II (double insulated) equipment designed for use in Pollution degree 2. 
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5.  TRANSMITTER FIELD WIRING 
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P6 Wiring Detail 

 

 

 

6.  READOUTS IN TEDS MODE 

 
When a SST Transmitter connected to a TEDS transducer is powered on, the transmitter reads 

the data stored in the transducer. The excitation supply is automatically set to the correct 

value, and the SST then calculates the correct scaling to calibrate the SST and transducer as a 

system. The jumper on the signal conditioner board must be set for the 50 mV range. See 

Section 10. If the Maximum Physical Value of the TEDS sensor exceeds 100,000, the 

calculated scale and offset are divided by 10, and the reading is in 10's of units. 

DPM-3-TRES Reader_Editor Software,  which is available from Transducer Techniques as an 

Accessory (see Section 17), allows the electronic data sheet for the transducer to be read 

through the RS232 port of the transmitter and be displayed on a computer screen. The values 

can be then be modified (e.g., to display kilograms instead of pounds) and be written back 

into the transducer. 

Instrument Setup (IS) Software can be used to further scale the reading or change decimal 

points. For example, if the full scale of the transducer is 50 pounds, the transmitter can be 

programmed to transmit 50, 50.0, 50.00, or 50.000 at full scale output – or an equivalent 

value in kilograms. Please see the next section of this manual. 
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7.  PROGRAMMING YOUR TRANSMITTER 

 
OVERVIEW 

The SST Transmitter is easily programmed using a PC with an RS232 port and Instrument 

Setup (IS) software, which provides a graphical user interface. This software is downloadable 

at no charge from http://www.transducertechniques.com/online-manuals.aspx. It allows up-

loading, editing, downloading and saving of setup data, execution of commands under 

computer control, listing, plotting and graphing of data.  

If your PC has an RS232 port, the transmitter and PC can be connected via the 3-wire RS232 

cable ACA-RJ11DS9, whose wiring is shown below: 

RS232 cable with rear view of DB9 

connector to PC 

 
  

If your PC only has a USB port but no RS232 port, connect the 3-wire RS232 cable ACA-

RS232DS9 to the RS232 to USB adapter cable ACA-USBDS9. This adapter cable is recom-

mended because it contains an FTDI chip, which is compatible with all versions of Windows, 

including Windows 7 and 10. 

GETTING STARTED WITH IS SOFTWARE 

As a first step, temporarily set User Account Control (UAC) of Windows to “Never notify” so 

that installation of “DPM-3/SST Instrument Setup” software can create directories. Use Google 

for instructions on how to change UAC settings for your version of Windows. Following instal-

lation, return UAC to its previous setting. 

To install IS software, download the file dpm-3-is.exe from our website and double-click on the 

file name. Click on “Install Instrument Setup Software” and follow the prompts. To launch IS 

software, press on Start => Programs => DPM-3 Digital Panel Meter => DPM-3 Instrument 

Setup. The splash screen below will appear: 

http://www.transducertechniques.com/online-manuals.aspx
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The Communications Setup screen will automatically appear a few seconds after the splash 

screen. Use this screen to select your communications Protocol, Device Type, and Commu-

nications Type. Selecting “None” for Communications Type allows you develop a setup file 

without being connected to an actual transmitter. 
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In the Establish Communications screen,  select your Com Port and 9600 and the Baud Rate. 

You will be able to change your protocol and baud rate later under the Communication setup 

tab. Click on Establish, and the two fields at the bottom of the screen should turn green. Click 

on the Main Menu button to open the Main Menu screen.  

From the Main Menu screen, click on DPM => Get Setup to retrieve (or get) the existing setup 

data from your DPM transmitter. Click on View => Setup to bring up screens which allow you to 

easily edit the setup file using pull-down menus and other selection tools. You can download 

(or put) your edited file into the transmitter by clicking on DPM => Put Setup. You can save 

your setup file to disk by clicking on File => Save Setup and retrieve a previously saved file from 

disk by click on File => Open. 

The best way to learn IS software is to experiment with it. 

For context-sensitive help for any data entry field under any tab, select that field and press the 

F1 key. 
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To get to the Input+Display tab, click on DPM => Get Setup to retrieve the current setup 

information from your DPM transmitter, then on View => Setup. Use the Input+Display screen 

to set up Signal Input, Display, and Control Inputs. The software reads the signal conditioner 

type, but not the range, which is set by jumpers. The “Sig Con Option” should be shown as 

“Load Cell”. The “50/60 Hz Line Freq” selection is used to optimize filtering to reject 50 or 60 

Hz electrical noise.  

Clicking on the Control Inputs field opens a pull-down menu which allows selection of the 

functions of Control Input 1, Control Input 2, and simultaneous Control Inputs 1 and 2. For 

example, with a Load Cell signal conditioner board and the highlighted selection, grounding 

Control Input 1 executes a Tare function, grounding Control Input 2 executes a Tare Reset, and 

grounding both Control Inputs 1 and 2 causes a Meter Reset, which resets Peak, Valley and 

latched alarms.  

Clicking on Read displays the current digital reading. The red background of the read field will 

then change from red to green. 

For detailed help on any data entry field, select that field and press the F1 key. 
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Click on the Scaling tab to scale your transmitter. If a TEDS transmitter is detected, you can 

enable or disable three items: Auto-Tare, TEDS LED indicator, and TEDS Plug and Play 

operation. Front Panel Tare does not apply to transmitters. The section “TEDS Data (Read 

Only)” displays data stored in EEPROM of the TEDS transducer. 

 

Three scaling methods are selectable if a non-TEDS transmitter is detected or if TEDS Plug and 

Play operation has been turned off: 1) Scale and Offset method, 2) Coordinates of 2 points 

method where (Low In, Low Read) and (High In, High Read) data points are entered 

numerically, and 3) Reading Coordinates of 2 points method, which uses actual readings.  



 - 13 - 

 

Click on the Filter tab to set to set up filtering for your readings. The adaptive threshold 

modifies the time constant in response to noise. 

Under Time Constant,  the filter time constant can be automatic, be set to batch, be specified in 

seconds, or be turned off. Automatic selects the time best filter time constant for the 

encountered noise level. Batch averages 16 consecutive measurements, which are taken at 

60/sec with 60 Hz power and 50/sec with 50 Hz power. Eight equivalent RC filter time constants 

can also be selected manually. The longer time constants provide superior noise filtering at the 

expense of fast response time. 

Adaptive moving average filtering allows the transmitter to reduce its time constant tempo-

rarily to reach a new value when filtering is not set to Batch or to No Filter. A Low Adaptive 

threshold allows a small change in signal to trigger a time constant reduction and is recom-

mended for normal low noise. A High Adaptive threshold requires a large change in signal to 

trigger a time constant reduction and is recommended for high noise environments. 

Peak/Valley values can be associated with either Unfiltered or Filtered readings.  

For detailed help on any data entry field, select that field and press the F1 key. 
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Click on the Relay Alarms tab to set up your transmitter’s two solid state relays, which are 

standard. For a complete explanation of Dual Relay Operation, see page 21. For detailed help on 

any data entry field, select that field and press the F1 key.  

 

Click on the Communication tab to view the communication parameters that you used to 

establish default communications with your transmitter. You can reselect Baud Rate, Device 

Address, Serial Protocol, and Full/Half Duplex, even though you may have selected different 

values to establish initial communications with your PC. For detailed help on any data entry 

field, select that field and press the F1 key. 
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Click on the Analog Out tab to scale your analog output. Under Range, select 4-20 mA, 0-20 

mA, 0-10V or -10V to +10V. To create the two endpoints of your analog output range, type in 

your Lo Range Reading and Hi Range Reading. For detailed help on any data entry field, select 

that field and press the F1 key. To change jumpers, see Section 9, Main Board Jumper Settings 

(page 19). 

ADDITIONAL INSTRUMENT SETUP PROGRAM FEATURES 

  The Commands pull-down menu allows you to execute certain functions by using your 

computer mouse. This menu will be grayed out unless a Get Setup has been executed. 

   The Readings pull-down menu provides four formats to display input data on your PC 

monitor. Press Pause to temporarily pause data collection. 

 

- Display presents the reading in large digit format. Press Tare to subtract the latest reading. 

Check Display Alarms to also show alarm status. Press End to return to Main Menu.  
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- List presents the latest internal readings in a 20-row by 10-column table. Press Pause at any 

time to freeze the display. Press Print for a hardcopy.  

- Plot generates a plot of internal readings vs. time in seconds. It effectively turns the 

transmitter-PC combination into a printing digital oscilloscope. 

- Graph generates a histogram, where the horizontal axis is the internal reading, and the 

vertical axis is the number of occurrences of readings. The display continually resizes itself 

as the number of readings increases. 

 

Plot 

 

Graph 
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   The Jumpers pull-down menu shows jumper positions for the load cell signal conditioner 

board and the main board, duplicating information in this manual. 

 

Jumpers 
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8.  OPENING YOUR TRANSMITTER CASE 

 
WHEN TO CHANGE JUMPERS 

Depending on your desired setup, the internal jumpers of the transmitter may need to be 

moved from their default positions to meet your needs. This will require opening the case. Note 

that while Instrument Setup Software senses the circuit board type, it does not sense jumper 

settings, and the corresponding information has to be entered manually. Jumpers are used for 

the following: 

1) On the signal conditioner board to set the signal type (e.g., voltage or current) and the 

range. For details, please see the next five sections of this manual. Note that all ranges of 

all signal conditioner boards are factory calibrated, with calibration factors stored in 

EPROM on the board.  

2) On the main board to set the serial communication signal (RS232 or RS485), termination 

resistor for long cable runs, analog output signal (current or voltage), and sensor excita-

tion output (5V, 10V or 24V). Default factory settings are voltage output, RS232, no 

termination resistor, and 10V excitation.  

HOW TO OPEN & CLOSE THE CASE 

  
 

The two clamshell halves of the case are held together with a bolt and a nut at each of the four 

corners. Use a Phillips screwdriver to remove the four bolts. The nut will then drop off, and the 

clamshell halves will separate. When closing the case, make sure that the ventilation grills are 

properly aligned.  

 

Caution: The nuts at each corner are not captive and are black. Take precautions 

so that the nuts do not get lost.  
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9.  MAIN BOARD JUMPER SETTINGS 

 

 

Serial Signal Duplex Jumpers Termination Resistor* 

RS485 
Full None 

E6 a = Transmit 

E6 c = Receive 

Half E6 b + d** E6 c 

RS232 Full None None 

*  The termination resistor jumper settings should only be selected if the transmitter is the last 

device on an RS485 line longer than 200 feet (60 m). 

**  Or connect external BTX to BRX and ATX to ARX (same effect as internal jumpers). 

To reset communications to 9600 baud, command mode, Custom ASCII protocol, and Address 1, 

place a jumper at E1 and power up the transmitter.  
 

Analog Output J4 Pins Jumpers 

Current, 4-20 mA 1 Lo, 2 Hi E2 a + d 

Voltage, 0-10V 1 Lo, 2 Hi E2 b + c 

Voltage, -10V to +10V 3 Lo, 2 Hi E2 b + c 

Jumper settings are for DPM main board Rev L 

Excitation Output* Jumpers 

5V, 100 mA E3 a + c; E4 a 

10V, 120 mA E3 a + c; E4 b 

24V, 50 mA E3 b, E4 none 
 

* Attempting to draw more than the rated excitation output current will shut down the output. 
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10.  LOAD CELL SIGNAL CONDITIONER BOARD JUMPER SETTINGS 

 

 

 

 

11.  TRANSMITTER CALIBRATION 

 
All analog input and analog output ranges of the transmitter have been digitally calibrated at the 

factory prior to shipment using calibration equipment certified to NIST standards. Calibration 

constants are stored digitally in non-volatile memory in EEPROM on the signal conditioner board 

and main board. This allows signal conditioner boards to be changed without requiring transmitter 

recalibration. 

Annual meter recalibration by the factory is recommended. Please contact Transducer 

Techniques for an RMA number. 

 

 

 

 

 

 

Load Cell & Microvolt Ranges 

b c

a d

e

 

FS Input Jumpers 

±20.000 mV 

±50.000 mV  

±100.00 mV 

±250.00 mV 

±500.00 mV 

e 
a 
b 
c 
d 
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12.  DUAL RELAY OPERATION   

 
Dual AC/DC solid state relays rated 120 mA are standard for alarm or setpoint control and are 

independently set up via the “Relay Alarms” tab of Instrument Setup Software. For online help 

with any data entry field, press the F1 key.  

 

 Setpoint. The number to which the current reading is compared if deviation is set to zero. The 

reading is the count in engineering units that is transmitted digitally and is also used for analog 

output. For example, if the transmitted reading is in gallons/minute, the setpoint will be 

referenced to that reading, not to the raw pulse rate sent from a turbine flow meter. 

Time
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 “Active High” On/Off setpoint control 

with deviation =0 

 “Active Low” On/Off setpoint control  

with deviation = 0 
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 Deviation. A positive number that can be added or subtracted from the setpoint, depending on 

the Deviation Type, to determine when an alarm becomes Active or Inactive.  

 Alarm State. If “Active High” is selected, the Active Alarm State is defined as being above the 

setpoint. If “Active Low” is selected, the Active Alarm State is defined as being below the 

setpoint. If “Disabled” is selected, the Alarm State is always inactive. 

 Relay State. A setting which ties the Relay State to the Alarm State. If “Active On” is selected, 

the relay will be closed when the Alarm State is 1. If “Active Off” is selected, the relay will be 

open when the Alarm State is 1. 

 Deviation Type. Three choices are offered: Band Deviation, Split Hysteresis, and Span 

Hysteresis. These define how Setpoint and Deviation are to be combined to set Alarm State. 

 

        Split Hysteresis for heater control      Band Deviation for component testing 

In Band Deviation, the relay opens (or closes) when the reading falls within the deviation 

band, and closes (or opens) when the reading falls outside. Two deviation limits lie symmetric-

ally around the setpoint to create the deviation band. Passbands around a setpoint are often 

used for go-no-go component testing. 

In Split Hysteresis, the relay opens (or closes) when the reading goes above the Setpoint plus 

one Deviation, and closes (or opens) when the reading falls below the Setpoint less one 

Deviation. Two Deviation limits lie symmetrically around the Setpoint to create a deviation 

band. A narrow hysteresis band is often used to minimize relay chatter. A wide band can be 

used for on-off control. 

In Span Hysteresis, operation is as for Split Hysteresis, except that the Setpoint is always on 

the high side, and a single Deviation lies below the Setpoint to create the hysteresis band. 

Span Hysteresis is considered by some to be more intuitive than Split Hysteresis. 

 Alarm Type. Selections are Non-Latching and Latching. Under Non-Latching, the relay is only 

closed (or open) while the Alarm State is Active. Under Latching, the activated relay remains 

closed (or opens) until reset regardless of the Alarm State. Resetting is normally achieved by 
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temporarily grounding one of the transmitter’s control inputs, which has been set to Function 

Reset under the “Input+Display” tab. 

 Alarms 1,2 No. Rdgs to Alarm. Selections are binary steps from 1 to 128. This is the number 

of consecutive alarm readings that must occur to create an Active alarm. Numbers higher than 

2 provide some Alarm filtering so that 1 or 2 noisy readings do not cause an Active Alarm. The 

Alarm becomes Inactive if one of the consecutive readings fails to be an Alarm reading. The 

Alarm readings counter then resets to 0. 
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13.  MODBUS PROTOCOL TRANSMITTER COMMUNICATIONS  

 

1.0  GENERAL 

The Modbus capability conforms to the Modbus over Serial Line Specification & Implemen-

tation Guide, V1.0. Both the Modbus RTU and Modbus ASCII protocols are implemented. This 

5-page manual section provides some of the key programmable Modbus features. 

 

Modbus RTU 

Baud Rate ........... 300, 600, 1200, 2400, 4800, 9600 or 19200 

Data Format ....... 1 start bit, 8 data bits, 1 parity bit, 1 stop bit (11 bits total) 

Parity .................. None, Odd, Even (if None, then 2 Stop bits for 11 total) 

Address .............. 0 for broadcast, 1-247 for individual meters 

Modbus ASCII 

Baud Rate ........... 300, 600, 1200, 2400, 4800, 9600 or 19200 

Data Format ....... 1 Start bit, 7 Data bits, 1 Parity bit, 1 Stop bit (10 bits total) 

Parity .................. None, Odd, Even (if None, then 2 Stop bits for 10 total) 

Address .............. 0 for broadcast, 1-247 for individual meters 

2.0  FRAMING 

Modbus RTU. Message frames are separated by a silent interval of at least 3.5 character times. 

If a silent interval of more than 1.5 character times occurs between two characters of the 

message frame, the message frame is considered incomplete and is discarded. Frame Check = 

16 bit CRC of the complete message excluding CRC characters. 

Modbus ASCII. The message begins immediately following a colon (:) and ends just before a 

Carriage Return/ Line Feed (CRLF). All message characters are hexadecimal 0-9, A-F (ASCII 

coded). The system allowable time interval between characters may be set to 1, 3, 5 or 10 

seconds. Frame Check = 1 byte (2 hexadecimal characters) LRC of the message excluding the 

initial colon (:) and trailing LRC and CRLF characters. 

3.0  ELECTRICAL INTERFACE 

RS232, two-wire half-duplex RS485, or four-wire full-duplex RS485 signal levels are selectable 

via jumpers on the transmitter main board and a the connector. Please see Section 9. The 

RS485 selection provides a jumper selection for insertion of a line termination resistor. In case 

of a long line (greater then 500 ft) to the first device, a termination resistor should be selected 

for the first device. In case of a long line between the first and last devices, a termination 

resistor should be selected for the first and last devices. Never add termination resistors to 

more than two devices on the same line. 
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4.0  COMMUNICATIONS SETUP 

Parameters selectable via Instrument Setup software, which is downloadable from our website: 

Serial Protocol ............................... Custom ASCII, Modbus RTU, Modbus ASCII 

Modbus ASCII Gap Timeout ........... 1 sec, 3 sec, 5 sec, 10 sec 

Baud Rate ....................................... 300, 600, 1200, 2400, 4800, 9600, 19200 

Parity  ............................................. No parity, odd parity, even parity 

Device Address  ............................. 0 to 247 

5.0  SUPPORTED MODBUS FUNCTION CODES, TM TRANSMITTERS W/ ANALOG INPUT 

FC03: Read Holding Registers 

Reads internal registers containing setup parameters (Scale, Offset, Setpoints, etc.) 

FC10: Write Multiple Registers (FC10 = 16 dec) 

Writes internal registers containing setup parameters (Scale, Offset, Setpoints, etc.) 

FC04: Read Input Registers 

Reads measurement values and alarm status. Returns values in 2's Complement Binary Hex 

format without a decimal point. The displayed system decimal point can be read with FC03 at 

address 0057.  Use only odd Register Addresses and an even number of Registers. 

Register Addr. TM Transmitter Response 

-------         ----------------------------------------------- 

00 01    Returns Hi word of Alarm status 

00 02    Returns Lo word of Alarm status 

00 03    Returns Hi word of Measurement value 

00 04    Returns Lo word of Measurement value  

00 05    Returns Hi word of Peak value 

00 06    Returns Lo word of Peak value   

00 07    Returns Hi word of Valley value 

00 08    Returns Lo word of Valley value  

FC05: Write Single Coil 

Action command to meter 

Output  Output  

Address   Value    Action Command 

-------   --------   ---------------------------------------- 

00 01    FF 00  Transmitter Reset (No Response) 

00 02    FF 00  Function Reset (Peak, Valley) 

00 03    FF 00    Latched Alarm Reset 

00 04    FF 00    Peak Reset 

00 05    FF 00    Valley Reset 

00 0C    FF 00    Tare Command (00 00 resets Tare) 
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FC08: Diagnostics 

Checks communications between the Master and Slave, and returns the count in the Modbus 

Slave counters (which are reset when the meter is reset). 

Hex Sub 

Function 

Code 

Data 

Send 

Response 

Data 
Description 

00 00 Any Same 

as sent 

Returns Query Data (N x 2 bytes). Echo Request.  

00 01 

FF 00 

00 00 

FF 00 

00 00 

Restarts Communications. If in the Listen-Only mode, no 

response occurs. Takes Slave out of the Listen-Only mode 

and one of the following: 

Clears communications event counters. 

Does not clear communications event counters. 

00 04 00 00 None Forces Listen-Only.  All addressed and broadcast 

Messages are monitored and counters are incremented, 

but no action is taken or response sent. Only Sub-

Function 00 01 causes removal of this Listen-Only state. 

00 0A 00 00 00 00 Clears all Modbus slave counters. 

00 0B 00 00 Total 

Message 

Count 

Returns total number of messages detected on the bus, 

including those not addressed to this Slave. Excludes bad 

LRC/CRC, parity error or length < 3. 

00 0C 00 00 Checksum 

Error 

Count 

Returns total number of messages with bad LRC/ CRC, 

parity or length < 3 errors detected on the bus including 

those not addressed to the Slave. 

00 0D 00 00 Exception 

Error 

Count 

Returns total number of Exception responses returned by 

the Addressed Slave or that would have been returned if 

not a broadcast message or if the Slave was not in a 

Listen-Only mode. 

00 0E 00 00 Slave 

Message 

Count 

Returns total number of messages, either broadcast or 

addressed to the Slave.  Excludes bad LRC/CRC, parity or 

length < 3 errors. 

00 0F 00 00 No 

Response 

Count 

Returns total number of messages, either broadcast or 

addressed to the Slave, for which Slave has returned No 

Response, neither a normal response nor an exception 

response. Excludes bad LRC/CRC, parity or length < 3 

errors. 

00 11 00 00 Slave 

Busy 

Returns total number of Exception Code 6 (Slave Busy) 

responses. 
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6.0  SUPPORTED EXCEPTION RESPONSE CODES 

Code Name      Error Description 

----  --------------------  ------------------------------------------------------ 

01    Illegal Function       Illegal Function Code for this Slave. Only hex Function 

   Codes 03, 04, 05, 08, 10 (dec 16) are allowed. 

02    Illegal Data Address   Illegal Register Address for this Slave. 

03 Illegal Data Value     Illegal data value or data length for the Modbus protocol. 

04    Slave Device Failure   Slave device failure (eg. Transmitter set for external gate). 

7.0  MESSAGE FORMATTING 

MA = Meter Address          DD = Data (Hex)        CL = CRC Lo Byte 

FC  = Function Code          WW = Data (On/Off)     CH = CRC Hi Byte 

RA = Register Address       SF = Sub-Function      CR = Carriage Return 

NR = Number of Registers    EC = Error Code        LF = Line Feed 

NB = Number of bytes        LRC = ASCII Checksum 

Modbus RTU Format 

FC Action 
> 3.5 

Char 

Byte Number 

1 2 3 4 5 6 7 8 9 10 11 

03 

03 

Request 

Response 

NoTx 

NoTx 

MA 

MA 

FC 

FC 

RA 

NB 

RA 

DD* 

NR 

DD* 

NR 

CL 

CL 

CH 

CH    

04 

04 

Request 

Response 

NoTx 

NoTx 

MA 

MA 

FC 

FC 

RA 

NB 

RA 

DD* 

NR 

DD* 

NR 

CL 

CL 

CH 

CH    

05 

05 

Request 

Response 

NoTx 

NoTx 

MA 

MA 

FC 

FC 

RA 

RA 

RA 

RA 

WW 

WW 

WW 

WW 

CL 

CL 

CH 

CH 

   

08 

08 

Request 

Response 

NoTx 

NoTx 

MA 

MA 

FC 

FC 

SF 

SF 

SF 

SF 

WW 

DD 

WW 

DD 

CL 

CL 

CH 

CH 

   

10 

10 

Request 

Response 

NoTx 

NoTx 

MA 

MA 

FC 

FC 

RA 

RA 

RA 

RA 

NR 

NR 

NR 

NR 

NB 

CL 

DD* 

CH 

DD* CL CH 

Exception 

Response 

NoTx MA FC 

+80 

EC CL CH       

DD* = (DD DD) times NR (Number of Registers) 
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Modbus ASCII Format 

FC Action 
Byte Number 

1 2 3 4 5 6 7 8 9 10 11 12 13 

03 

03 

Request 

Response 

: 

: 

MA 

MA 

FC 

FC 

RA 

NB 

RA 

DD* 

NR 

DD* 

NR 

LRC 

LRC 

CR 

CR 

LF 

LF    

04 

04 

Request 

Response 

: 

: 

MA 

MA 

FC 

FC 

RA 

NB 

RA 

DD* 

NR 

DD* 

NR 

LRC 

LRC 

CR 

CR 

LF 

LF    

05 

05 

Request 

Response 

: 

: 

MA 

MA 

FC 

FC 

RA 

RA 

RA 

RA 

WW 

WW 

WW 

WW 

LRC 

LRC 

CR 

CR 

LF 

LF 

   

08 

08 

Request 

Response 

: 

: 

MA 

MA 

FC 

FC 

SF 

SF 

SF 

SF 

WW 

DD 

WW 

DD 

LRC 

LRC 

CR 

CR 

LF 

LF 

   

10 

10 

Request 

Response 

: 

: 

MA 

MA 

FC 

FC 

RA 

RA 

RA 

RA 

NR 

NR 

NR 

NR 

NB 

LRC 

DD* 

CR 

DD* 

LF 

LRC CR LF 

Exception 

Response 

: MA FC 

+80 

EC LRC CR LF       

DD* = (DD DD) times NR (Number of Registers) 

8.0  MESSAGE EXAMPLES 

   All examples are for Transmitter Address = 01 and No Parity. 

Ser_4 -> 

Addr -> 

Action 

Modbus RTU 

010 

001 

Modbus ASCII 

020 

001 

Restart Com-

munications 

Request 

Response* 

010800010000B1CB 

010800010000B1CB 

:010800010000F6crlf 

:010800010000F6crlf 

Meter Reset Request 

Response 

01050001FF00DDFA 

None 

:01050001FF00FAcrlf 

None 

Digital Reading 

** *** 

Request 

Response 

01040003000281CB 

010404000009D67C4A 

:010400030002F6crlf 

:010404000009D618crlf 

Write Setpoint 

1 = +37.00*** 

Request 

Response 

0110000100020400000E743624 

01030400000E74FE74 

:0110000100020400000E7466crlf 

:011000010002ECcrlf 

Read Setpoint 

1 = +37.00*** 

Request 

Response 

01030001000295CB 

01030400000E74FE74 

:010300010002F9crlf 

:01030400000E7476crlf 

*  Suggested as first message after power-up. If transmitter is in Listen-Only mode, no response 

    is returned.  ** Example while reading +25.18  ***  Decimal point is ignored. 

9.0   INTERNAL REGISTERS:  Please refer to the full Modbus Protocol Communications Manual.  
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14.  CUSTOM ASCII PROTOCOL TRANSMITTER COMMUNICATIONS  

 

1.0    SERIAL COMMUNICATION FORMAT 
 

The Custom ASCII serial communication format for both RS232 and RS485 is the following: 

Mode ................ Full Duplex (Separate transmit and receive lines) and Half Duplex (RS485 only) 

Baud Rate ......... 300, 600, 1200, 2400, 4800, 9600, 19200 selectable with Instrument Setup 

software. 

Parity ................ None 

Word length ...... 8 data bits 

Stop bit  ............ 1 

This 5-page manual section provides some of the key programmable Custom ASCII protocol 

features. Our detailed Serial Communications manual can be downloaded from 

www.transducertechniques.com/online-manuals.aspx.  
 

2.0    MEASUREMENT DATA FORMAT 
 

The basic measurement data format consists of 8 ASCII characters for analog input “DPM” 

transmitters, such as +999.99<CR>, where <CR> is the carriage return character. The first 

character is always a plus or minus sign. A decimal point is always furnished, even when it 

follows the last digit. 

Adding a Line Feed Character to the Basic Format. Printers and other devices that receive the 

data may require a line feed character <LF> following the <CR>. The line feed character <LF> 

may be selected using Instrument Setup software. 

Adding a Coded Data Character to the Basic Format. A coded character from A to H may be 

added to the data string according to the table below to indicate the alarm and overload status 

of the device. If used, this character precedes the <CR>, so that it is the last printable character 

in the string. With the optional <LF> and coded character selected, the data string will consist 

of 10 characters for analog input “DPM” transmitters, such as +999.99A<CR><LF>. 

Alarm Status No Overload Overload 

Neither Alarm set 

Alarm 1 set only 

Alarm 2 set only 

Both Alarms set 

A 

B 

C 

D 

E 

F 

G 

H 

 

For example, a coded character “G” indicates that Alarm 2 only is set and that the transmitter is 

in the overload condition. This information is useful when data is supplied to a computer for 

listing and analysis, or when data is supplied to a Remote Display in a Master-Slave confi-

guration. 

http://www.transducertechniques.com/online-manuals.aspx
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Values are transmitted in a continuous string with no intervening spaces. If the 5th digit in is 

set to 1 using Instrument Setup software, the termination characters of <CR> and optional 

<LF> appear after each value. If the 5th digit is set to 0, the termination characters appear only 

once at the end of the string. In either case, if included, the coded character appears at the end 

of the last value only. 

3.0    NETWORK CONFIGURATIONS 

Using the Custom ASCII protocol, TM Series transmitters can operate in a point-to-point mode 

using RS232 or RS485, or in a multi-point mode using RS485. 

The point-to-point mode is a direct connection between a computer (or other digital device) 

and the transmitter. An device address can be selected; however, it is suggested that address 1 

be selected as a standard for the point-to-point mode. 

The multi-point mode is a connection from a host computer to a multiplicity of transmitters 

bused together with their inputs and outputs connected in parallel. For long cable runs, the last 

device should have a termination resistor installed. It is necessary to set up each device  on the 

bus with a different address from 1 to 31. To command a particular device, its address is used 

in conjunction with the command, and only that device responds. The outputs of all of the 

devices on the bus are set to a high impedance state, except the device being addressed. The 

device addresses range from 1 to 31, with 0 being a special address to which a meter responds 

only internally (e.g. Reset), but does not transmit any response on the output lines. All devices 

may be commanded simultaneously with a 0 address, and there will not be any output 

response contention.  Addressing of transmitters can be set with Instrument Setup software.    

4.0   COMMAND MODE OVERVIEW  

Using the Custom ASCII protocol, SST transmitters operate in the Command Mode only. In this 

mode, the device does not send data automatically, but responds to commands received from a 

host computer. These commands can be: 

 To transmit the latest or peak measurement 

 To reset the meter completely or just the peak value and/or latched alarms 

 To display a value sent from the computer 

 To transmit present setup parameters 

 To receive new setup parameters, 

 To monitor or alter data in selected memory locations of the meter. 

5.0   COMMAND MODE FORMAT 

CHAR 1 - Command Identifier 

All commands begin with “*” followed by the meter address, then a command letter followed 

by a sub-command number or letter. Additional characters may be appended. All commands 

terminate with <CR> (<LF> ignored). 
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Char # Character Description 

1 

2 

3 

4 

* 

0-V 

A-Z 

0-U 

Command Identifier. Recognition Character. 

Device Address. 0 addresses all devices, 1-V specific devices. 

Command Function 

Sub-command. Number of Bytes of RAM or Words (2 Bytes) of 

non-volatile memory data being transferred. 

CHAR 2 - Address Codes 

A Serial Communications Address Code from 1 to V follows the “*” to indicate the device 

address number from 1 to 31. 

Device # 
Address 

Code 
 Device # 

Address 

Code 

 
Device # 

Address 

Code 

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

1 

2 

3 

4 

5 

6 

7 

8 

9 

A 

B 

 12 

13 

14 

15 

16 

17 

18 

19 

20 

21 

22 

C 

D 

E 

F  

G 

H 

I 

J 

K 

L 

M 

 23 

24 

25 

26 

27 

28 

29 

30 

31 

N 

O 

P 

Q 

R 

S 

T 

U 

V 

CHARS 3 & 4 - Commands and Subcommands 

The examples below use a default address of 1 following the “*“. Substitute the desired 

address from the above table of Serial Comm Address Codes. All command sequences shown 

must terminate with <CR>, followed by an optional <LF>. 

Request DPM Values 

Get reading**    *1B1 

Peak reading    *1B2 

Valley reading   *1B3 

**  The meter transmits the output items selected with Instrument Setup software. 

Reset Functions, DPM Transmitter 

Cold reset     *1C0   Reads NVMEM into RAM locations after RAM is zeroed. 

Latched alarms reset  *1C2 
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Peak value reset   *1C3 

Remote display reset  *1C4 

Valley reset    *1C9 

Tare function    *1CA 

Tare reset     *1CB 

6.0    READING AND WRITING TO RAM AND NONVOLATILE MEMORY 

CHAR 1, 2 

The Recognition character and Meter Address Code are the same as shown in previous table. 

CHAR 3 

Command character: 

  G  Read bytes from RAM Memory 

  F  Write bytes to RAM Memory (DPM and Scale meter only) 

  R  Read bytes from Upper RAM Memory 

  Q  Write bytes to Upper RAM Memory 

  X  Read words from Non-Volatile Memory 

  W  Write words to Non-Volatile Memory 

CHAR 4 

Command character. Sub-command. Number of Bytes of RAM or Words (2 Bytes) of non-

volatile memory data being transferred. 

Code # Number  Code # Number  Code # Number 

1 

2 

3 

4 

5 

6 

7 

8 

9 

A  

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

 B  

C 

D 

E 

F  

G 

H 

I 

J 

K 

11 

12 

13 

14 

15 

16 

17 

18 

19 

20 

 L 

M  

N 

O 

P 

Q 

R 

S 

T 

U 

21 

22 

23 

24 

25 

26 

27 

28 

29 

30 

CHAR 5, 6 

See tables for the RAM MEMORY ADDRESSES and NONVOLATILE MEMORY ADDRESSES with 

their respective data definitions. 
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General, Reading and Writing Ram Memory Data 

RAM memory data is read and written as a continuous string of bytes consisting of 2 hex 

characters (0-9,A-F) per byte. Included in the command are the total number of bytes to be 

transferred and the most significant address in RAM of the continuous string of bytes. The 

format is: 

Read lower RAM data *1Gnaa   

Write lower RAM data *1Fnaa<data> 

Read upper RAM data *1Rnaa   

Write upper RAM data *1Qnaa<data> 

where:   

n is the number of bytes to be read or written. 

aa is the most significant address in RAM of the bytes to be read or written. 

<data> is n bytes of 2 hex characters per byte in order from the most to the least significant 

byte. 

The number of bytes n consists of a single code character representing values from 1 to 30 as 

shown above under CHARACTER 4. The most significant address aa consists of 2 hex charac-

ters as shown below under RAM MEMORY ADDRESSES AND DATA DEFINITIONS. 

General, Reading and Writing Nonvolatile Memory Data 

Nonvolatile data is read and written as a continuous string of words consisting of 2 bytes or 4 

hex characters (0-9,A-F) per word.  Included in the command is the total number of words to 

be transferred and the most significant address in nonvolatile memory of the continuous string 

of words.  The format is: 

Read nonvolatile memory data    *1Xnaa   (followed by Meter reset) 

Write non-volatile memory data   *1Wnaa <data> (followed by Meter reset) 

where: 

n is the number of words to be read or written. 

aa is the most significant address in nonvolatile memory of the words to be read or written. 

<data> is n words of 2 bytes or 4 hex characters per word in order from the most to the  least 

significant address. 

The coded number of words n consists of a single character representing values from 1 to 30 

as shown under CHARACTER 4. The most significant address aa consists of 2 hex characters 

as shown under NONVOLATILE MEMORY ADDRESSES. 
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15.  SST TRANSMITTER SPECIFICATIONS  

 

Load Cell & Microvolt Input Signal Conditioner 

Full scale ranges ................... ±20.000 mV, ±50.000 mV, ±100.00 mV, ±250.00 mV, ±500.00 mV 

Input resistance ................................................................................................................ 1 Gohm 

Input accuracy at 25°C ................................................................. ± 0.01% of full span ±2 counts 

Max applied voltage ................................................................................................................ 35V 

Transducer Excitation Output (standard) 

Excitation level (factory default) .................................................................. 10 Vdc ± 5%, 120 mA 

Other excitation levels (jumper selectable) ................ 5 Vdc ± 5%, 100 mA; 24 Vdc ± 5%, 50 mA 

Output Isolation ....................................................................................... 50 Vdc to meter ground 

Analog to Digital Conversion) 

Conversion rate ..................................................... 60/sec at 60 Hz power, 50/sec at 50 Hz power 

Input resolution .......................................................................................... 16 bits (65,536 steps) 

Accuracy 

Input Range Resolution 
Output Zero 

Range 

Output Span 

Range 
Error at 25°C 

±20.000 mV 

±50.000 mV 

±100.00 mV 

±250.00 mV 

±500.00 mV 

1 µV 

1 µV 

10 µV 

10 µV 

10 µV 

-99,999 

to 

+99,999 

-99,999 

to 

+99,999 

±0.01% of  

reading 

±2 counts 

Span Tempco (load cell signal conditioner) .............................................. 0.0015% of reading/°C 

Zero Tempco ...................................................................................................................0.2 µV/°C 

Input Signal Noise Rejection 

CMV, DC to 60 Hz ......................................................................................................... 250V RMS 

CMR, DC to 60 Hz .............................................................................................................. 130 dB 

NMR at 50/60 Hz ............................................................................. 90 dB with no digital filtering 

Input filtering ..................................... User-selectable digital time constants from 80 ms to 9.6 s 

Transmitter Setup 

Selection of signal ranges .................................................... Jumpers on signal conditioner board 

Selection of serial format, excitation output, analog output ..................... Jumpers on main board 

Programming ........................................ Via PC using Instrument Setup software and serial cable 
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TEDS Compliance 

Standards compliance ...................................................................................... TEDS IEEE 1451.4 

Software support ................................ TEDS Reader_Editor Software (available as an accessory) 

Analog Output (standard) 

Output levels ....................................... 4-20 mA, 0-20 mA, 0-10V, -10V to +10V (user selectable) 

Compliance at 20 mA .............................................................................. 10V (0 to 500 ohm load) 

Compliance at 10V .......................................................................... 2 mA (5 kohm or higher load) 

Output resolution ........................................................................................ 16 bits (65,536 steps) 

Output accuracy .............................................................................................. ±0.02% of full span  

Output isolation ...................................... Safety rated to 250 Vrms, 4.2 kV per High Voltage Test 

Serial I/O (standard) 

Serial formats ............................................ RS232 or RS485 (half or full duplex), user selectable 

Serial protocol ............................................................. Custom ASCII or Modbus (RTU or ASCII) 

Modbus Compliance ...................................... Modbus over Serial Line Specification V1.0 (2002) 

Serial connector ......................................................................... Detachable screw terminal plugs 

Baud rates ........................................................... 300, 600, 1200, 2400, 4800, 9600, 19200 baud 

Output isolation ...................................... Safety rated to 250 Vrms, 4.2 kV per High Voltage Test 

Dual Relay Output (standard) 

Relay type ................................................... Two solid state relays, SPST, normally open, Form A 

Load rating ........................................ 120 mA at 140 Vac or 180 Vdc, 28 ohms series resistance 

Power & Electrical 

Power to Transmitter (standard power) ............................................... 85-264 Vac or 90-300 Vdc 

Power to Transmitter (low voltage power option).................................... 12-32 Vac or 10-48 Vdc 

Power Isolation ....................................... Safety rated to 250 Vrms, 4.2 kV per High Voltage Test 

Mechanical 

Case dimensions .......................................................................................... 120 x 101 x 22.5 mm 

Case mounting ................................................................................ 35 mm DIN rail per EN 50022 

Electrical connections ............................................................. Detachable screw plug connectors 

Environmental 

Operating temperature ................................................................................................ 0°C to 70°C 

Storage temperature ................................................................................................ -40°C to 85°C 

Relative humidity ........................................................... 95% from 0°C to 40°C, non-condensing 
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16.  ACCESSORIES  

 

INSTALLATION INSTRUCTIONS

1. Remove the three (3) connectors from the J5 location at the rear of the DPM-3 meter

(See DPM-3 Operator Manual, Page 4, Section 5.1 for illustration of J5 location)

2. Install the AAC-DS9 Adapter Connector at the J5 location

AAC-DS9

Adapter Connector

Full Wheatstone Bridge

Transducer

Load Cell

Force Sensor

Torque Sensor

Pressure Transducer

MLP Series

Load Cell

+

+

 Signal (Green)

 Excitation (Red)

    

    

Signal (White)

1 2 3 4 5

6 7 8 9

Excitation (Black) & Shield

Ground ( Shield )

Figure 1 NON-TEDS Load Cell / Torque Sensor

Wiring Diagram / Schematic

Female DS9 Connector

Attached to Load Cell

+

+

 Signal (Green)

 Excitation (Red)

    Install Jumper between Pins 3 & 4

    TEDS Data (Brown)

    TEDS Ground   

    

    Excitation (Black) & Shield

    

(Blue) 

Signal (White)

Full Wheatstone Bridge

Transducer

Load Cell

Force Sensor

Torque Sensor

Pressure Transducer

MLP Series

Load Cell

1 2 3 4 5

6 7 8 9

Ground ( Shield )

TEDS IEEE 1451.4

Smart Load Cell / Torque Sensor

Figure 2

Female DS9 Connector

Attached to Load Cell
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ACA-PC6 or ACA-PC12 
6 feet or 12 feet. Transmitter Power 
Cable. Can also be used with DPM-3 
Digital Panel Meter 

 
 
 
 
ACA-RS232DS9 
Serial Output Cable to PC COM Port  

 
 
 
 
ACA-USBDS9 
Serial to USB Adapter Cable & Disk. 
Can be connected to ACA-RJ11DS9 

 
  

DPM-3-DLS 
Data Logging Software 

 

DPM-3-TRES 
TEDS Reader_Editor Software 

 

 
 

 

 

 

 



 - 38 - 

17.  WARRANTY & REPAIR POLICY 

Limited Warranty on Products 

Any of our products which, under normal operating conditions, proves defective in material 
or in workmanship within one (1) year from the date of shipment by Transducer Techniques, 
will be repaired or replaced free of charge provided that you obtain a return material 
authorization from Transducer Techniques and send the defective product, transportation 
charges prepaid with notice of the defect, and establish that the product has been properly 
installed, maintained, and operated within the limits of rated and normal usage. Replace-
ment product will be shipped F.O.B. our plant. The terms of this warranty do not extend to 
any product or part thereof which, under normal usage, has an inherently shorter useful life 
than one year. The replacement warranty detailed here is the Buyer’s exclusive remedy, 
and will satisfy all obligations of Transducer Techniques, whether based on contract, 
negligence, or otherwise. Transducer Techniques is not responsible for any incidental or 
consequential loss or damage which might result from a failure of any Transducer 
Techniques’ product. This express warranty is made in lieu of any and all other warranties, 
expressed or implied, including implied warranty of merchantability or fitness for particular 
purpose. Any unauthorized disassembly or attempt to repair voids this warranty. 

Obtaining Service Under Warranty 

Advance authorization is required prior to the return to Transducer Techniques. Before 
returning the item(s), either write to the Repair Department c/o Transducer Techniques, 
42480 Rio Nedo, Temecula, CA 92590, or call (951) 719-3965 with: 1) a part number; 2) a 
serial number for the defective product; 3) a technical description of the defect; 4) a no-
charge purchase order number (so products can be returned to you correctly); and, 5) ship 
to and bill to addresses. Shipment to Transducer Techniques shall be at Buyer’s expense, 
and repaired or replacement items will be shipped F.O.B. our plant in Temecula CA.  Non-
verified problems or defects may be subject to a $75 evaluation charge. Please return the 
original calibration data with the unit. 

Obtaining Non-Warranty Service 

Advance authorization is required prior to the return to Transducer Techniques. Before 
returning the item(s), either write to the Repair Department c/o Transducer Techniques, 
42480 Rio Nedo, Temecula, CA 92590, or call (951) 719-3965 with: 1) a model number; 2) 
a serial number for the defective product; 3) a technical description of the malfunction; 4) a 
purchase order number to cover Transducer Techniques’ repair cost; and 5) ship to and bill 
to addresses. After the product is evaluated by Transducer Techniques, we will contact you 
to provide the estimated repair costs before proceeding. The minimum evaluation charge is 
$75. Shipment to Transducer Techniques shall be at Buyer’s expense, and repaired items 
will be shipped to you F.O.B. our plant in Temecula, CA. Please return the original calibra-
tion data with the unit. 

Repair Warranty 

All repairs of Transducer Techniques’ products are warranted for a period of 90 days from 
the date of shipment.  This warranty applies only to those items which were found defective 
and repaired; it does not apply to products in which no defect was found and returned as is, 
or merely re-calibrated.  Out of warranty products may not be capable of being returned to 
the exact original specifications or dimensions. 

FOR TECHNICAL SUPPORT, CALL (800) 344-3965 OR FAX (951) 719-3900 
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(800) 344-3965

E-mail:  tti@ttloadcells.com

Load Cells
Force/Torque

Sensors TM

Techniques

Transducer
R

 Temecula, CA 92590

www.transducertechniques.com

 
 

 


